
 

OL-13543-01
C H A P T E R3

Preparing for Installation

Revised: May 25, 2007, OL-13543-01

This chapter describes safety instructions and site requirements for installing the MARS Appliance and 
guides you through installation preparation. It contains the following sections:

• Safety, page 3-1

• Preparing Your Site for Installation, page 3-5

• Precautions for Rack-Mounting, page 3-8

• Required Tools and Equipment, page 3-9

• Packaging Contents Checklist, page 3-9

• Selecting the Appropriate Rail Kit, page 3-10

• Web Browser Client Requirements, page 3-10

Safety
This section provides safety information for installing this product.

Warnings and Cautions
Read the installation instructions in this document before you connect the system to its power source. 
Failure to read and follow these guidelines could lead to an unsuccessful installation and possibly 
damage the system and components.

You should observe the following safety guidelines when working with any equipment that connects to 
electrical power or telephone wiring. They can help you avoid injuring yourself or damaging the MARS 
Appliance.

Note The English warnings in this document are followed by a statement number. To see the translations of a 
warning into other languages, look up its statement number in the Regulatory Compliance and Safety 
Information for the MARS 5.x

The following warnings and cautions are provided to help you prevent injury to yourself or damage to 
the devices:
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Safety
Warning Before working on a system that has an On/Off switch, turn OFF the power and unplug the power cord. 
Statement 1

Warning Before working on a chassis or working near power supplies, unplug the power cord on AC units; 
disconnect the power at the circuit breaker on DC units. Statement 12

Warning This unit is intended for installation in restricted access areas. A restricted access area is where 
access can only be gained by service personnel through the use of a special tool, lock and key, or 
other means of security, and is controlled by the authority responsible for the location. Statement 37

Warning This unit might have more than one power cord. To reduce the risk of electrical shock, disconnect all 
power supply cords before servicing the unit. Statement 106

Warning The safety cover is an integral part of the product. Do not operate the unit without the safety cover 
installed. Operating the unit without the cover in place will invalidate the safety approvals and pose 
a risk of fire and electrical hazards. Statement 117

Warning Do not work on the system or connect or disconnect cables during periods of lightning activity. 
Statement 1001.

Warning Read the installation instructions before you connect the system to its power source. Statement 1004

Warning To prevent bodily injury when mounting or servicing this unit in a rack, you must take special 
precautions to ensure that the system remains stable. The following guidelines are provided to ensure 
your safety: Statement 1006

Warning There is the danger of explosion if the battery is replaced incorrectly. Replace the battery only with 
the same or equivalent type recommended by the manufacturer. Dispose of used batteries according 
to the manufacturer’s instructions. Statement 1015

Warning This equipment must be grounded. Never defeat the ground conductor or operate the equipment in the 
absence of a suitably installed ground conductor. Contact the appropriate electrical inspection 
authority or an electrician if you are uncertain that suitable grounding is available. Statement 1024
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Safety
Warning Blank faceplates and cover panels serve three important functions: they prevent exposure to 
hazardous voltages and currents inside the chassis; they contain electromagnetic interference (EMI) 
that might disrupt other equipment; and they direct the flow of cooling air through the chassis. Do not 
operate the system unless all cards, faceplates, front covers, and rear covers are in place. Statement 
1029

Warning Ultimate disposal of this product should be handled according to all national laws and regulations. 
Statement 1040

Warning Before opening the chassis, disconnect the telephone-network cables to avoid contact with 
telephone-network voltages. Statement 1041

Warning This product requires short-circuit (overcurrent) protection, to be provided as part of the building 
installation. Install only in accordance with national and local wiring regulations. Statement 1045

Warning IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you 
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar 
with standard practices for preventing accidents. Use the statement number provided at the end of 
each warning to locate its translation in the translated safety warnings that accompanied this device. 
Statement 1071

SAVE THESE INSTRUCTIONS

General Precautions
Observe the following general precautions when using and working with your system: 

• Keep your system components away from radiators and heat sources, and do not block cooling vents.

• Do not spill food or liquids on your system components, and never operate the product in a wet 
environment. If the computer gets wet, see the appropriate chapter in your troubleshooting guide or 
contact the Cisco Technical Assistance Center. For instructions on contacting the Technical 
Assistance Center, see Obtaining Documentation, Obtaining Support, and Security Guidelines, 
page xli, in the Preface. 

• Do not push any objects into the openings of your system components. Doing so can cause fire or 
electric shock by shorting out interior components.

• Position system cables and power cables carefully; route system cables and the power cable and plug 
so that they cannot be stepped on or tripped over. Be sure that nothing rests on your system 
components’ cables or power cable.

• Do not modify power cables or plugs. Consult a licensed electrician or your power company for site 
modifications. Always follow your local/national wiring rules.
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Safety
• To avoid possible damage to the system board, wait 5 seconds after turning off the system before 
removing a component from the system board or disconnecting a peripheral device from the 
computer.

Maintaining Safety with Electricity
Follow these guidelines when working on equipment powered by electricity:

• If any of the following conditions occur contact the Cisco Technical Assistance Center:

– The power cable or plug is damaged.

– An object has fallen into the product.

– The product has been exposed to water.

– The product has been dropped or damaged.

– The product does not operate correctly when you follow the operating instructions.

• Use the correct external power source. Operate the product only from the type of power source 
indicated on the electrical ratings label. If you are not sure of the type of power source required, 
consult the Cisco Technical Assistance Center or a local power company.

• Use only approved power cable(s). You have been provided with a power cable for your MARS 
Appliance that is intended for your system (approved for use in your country, based on the shipping 
location). Should you have to purchase a power cable, ensure that it is rated for the product and for 
the voltage and current marked on the product’s electrical ratings label. The voltage and current 
rating of the cable should be greater than the ratings marked on the product.

• To help prevent electric shock, plug the MARS Appliance, components, and peripheral power cables 
into properly grounded electrical outlets. These cables are equipped with three-prong plugs to help 
ensure proper grounding. Do not use adapter plugs or remove the grounding prong from a cable. 

• Observe power strip ratings. Make sure that the total ampere rating of all products plugged into the 
power strip does not exceed 80% of the rating. 

• To help protect your system and components from sudden, transient increases and decreases in 
electrical power, Cisco recommends the use an uninterruptable power supply (UPS) for your MARS 
Appliances. 

• Do not modify power cables or plugs. Consult a licensed electrician or your power company for site 
modifications. Always follow your local and national wiring rules.

Protecting Against Electrostatic Discharge
Static electricity can harm delicate components inside your computer. To prevent static damage, 
discharge static electricity from your body before you touch any of your computer’s electronic 
components, such as the microprocessor. You can do so by touching an unpainted metal surface on the 
computer chassis.

As you continue to work inside the computer, periodically touch an unpainted metal surface to remove 
any static charge your body may have accumulated.

You can also take the following steps to prevent damage from electrostatic discharge (ESD):
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• When unpacking a static-sensitive component from its shipping carton, do not remove the 
component from the antistatic packing material until you are ready to install the component in your 
computer. Just before unwrapping the antistatic packaging, be sure to discharge static electricity 
from your body.

• When transporting a sensitive component, first place it in an antistatic container or packaging.

• Handle all sensitive components in a static-safe area. If possible, use antistatic floor pads and 
workbench pads.

Preventing EMI
When you run wires for any significant distance in an electromagnetic field, electromagnetic 
interference (EMI) can occur between the field and the signals on the wires.

Note Bad plant wiring can result in radio frequency interference (RFI).

Note Strong EMI, especially when it is caused by lightning or radio transmitters, can destroy the signal drivers 
and receivers in the system, and can even create an electrical hazard by conducting power surges through 
lines and into the system.

To predict and remedy strong EMI, consult RFI experts.

Preparing Your Site for Installation
This section describes the requirements your site must meet for safe installation and operation of your 
MARS Appliance. Ensure that your site is properly prepared before beginning installation.

Environmental
When planning your site layout and equipment locations, remember the precautions described in this 
section to help avoid equipment failures and reduce the possibility of environmentally caused 
shutdowns. If you are experiencing shutdowns or unusually high errors with your existing equipment, 
these precautions will help you isolate the cause of failures and prevent future problems. 

Use the following precautions when planning the operating environment for your MARS Appliance:

• Always follow the ESD-prevention procedures described in Preventing EMI, page 3-5, to avoid 
damage to equipment. Damage from static discharge can cause immediate or intermittent equipment 
failure. 

• Make sure that the chassis cover is secure. The chassis allows cooling air to flow effectively within 
it. An open chassis allows air leaks, which could interrupt and redirect the flow of cooling air from 
internal components.

• Electrical equipment generates heat. Ambient air temperature might not be adequate to cool 
equipment to acceptable operating temperatures without adequate circulation. Make sure that the 
room in which you operate has adequate air circulation.

Also, verify that make sure your environment is suitable for the MARS Appliance:
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Choosing a Site for Installation

Warning This unit is intended for installation in restricted access areas. A restricted access area is where 
access can only be gained by service personnel through the use of a special tool, lock and key, or 
other means of security, and is controlled by the authority responsible for the location. Statement 37 

• Choose a site with a dry, clean, well-ventilated and air-conditioned area.

• Choose a site that maintains an ambient temperature of 10° to 35°C (50° to 95°F).

• Choose a site with sufficient room in the front to open the hot-swappable hard drives (about ten 
inches).

• Choose a site with sufficient room in the rear to attach the power cords and Ethernet cables (about 
four inches).

• Avoid areas that receive direct sunlight.

Table 3-1 Environmental Specifications for MARS 110R, 110, 210, and GC2 

Environmental Parameter MARS 110 and MARS 110R MARS 210, and GC2

Temperature range Operating: +10°C to +35°C with 
the maximum rate of change not to 
exceed 10°C per hour 

Non-operating: 
–40° C to +70° C 

Operating: +10°C to +35°C with 
the maximum rate of change not to 
exceed 10°C per hour 

Non-operating: 
–40° C to +70° C 

Relative humidity Non-operating: 90%

Non-condensing at +28°C 

Non-operating: 90%

Non-condensing at +28°C 

System Cooling 
Requirement

1,826 BTU/hour 1,826 BTU/hour 

Vibration Unpackaged: 5 Hz to 500 Hz, 
2.20 g RMS random

Unpackaged: 5 Hz to 500 Hz, 
2.20 g RMS random

Shock

OL-13543-01

Operating: Half sine, 2 g peak, 
11 mSec

Unpackaged: Trapezoidal, 25 g, 
velocity change 136 inches/sec 

Packaged: Non-palletized free fall 
in height 24 inches 
(>= 40 lbs to < 80 lbs)

Operating: Half sine, 2 g peak, 
11 mSec

Unpackaged: Trapezoidal, 25 g, 
velocity change 136 inches/sec

Packaged: Non-palletized free fall 
in height 24 inches 
(>= 40 lbs to < 80 lbs)

Altitude

Acoustic Noise Sound Pressure: 55 dBA (Rack 
mount) in an idle state at typical 
office ambient temperatures 

Sound Power: 7.0 BA in an idle 
state at typical office ambient 
temperatures. 

Sound Pressure: 55 dBA (Rack 
mount) in an idle state at typical 
office ambient temperatures 

Sound Power: 7.0 BA in an idle 
state at typical office ambient 
temperatures. 
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Grounding the System

Warning Never defeat the ground conductor or operate the equipment in the absence of a suitably installed 
ground conductor. Contact the appropriate electrical inspection authority or an electrician if you are 
uncertain that suitable grounding is available. Statement 213 

Creating a Safe Environment

Follow these guidelines to create a safe operating environment:

• Keep tools and chassis components off the floor and away from foot traffic.

• Clear the area of possible hazards, such as moist floors, ungrounded power extension cables, and 
missing safety grounds.

• Keep the area around the chassis free from dust and foreign conductive material (such as metal 
flakes from nearby construction activity).

AC Power
Ensure that the plug-socket combination is accessible at all times, because it serves as the main 
disconnecting device.  

Warning This product requires short-circuit (overcurrent) protection, to be provided as part of the building 
installation. Install only in accordance with national and local wiring regulations. Statement 1045

Cabling
Use the cables in the accessory kit to connect the MARS Appliance console port to a console or computer 
that is running a console program. In addition to using the console cable, use the provided standard 
Ethernet cable to connect the MARS Appliance to your network. For information detailing cable 
requirements, see Network Cable Requirements, page 1-4. 

Inline Filter for the Modem
An inline filter for line impedance matching is shipped in the Accessory Kit. Insert the male RJ-11 
connector of the filter into the Line-in socket of the MARS modem. Insert the local telephone cable into 
the RJ-11 socket of the filter. 

The following countries require the filter to be used with the MARS modem: 

Australia, Austria, Belgium, China, Czech Republic, Denmark, Finland, France, Germany, Greece, 
Hungary, Ireland, Italy, Korea, Luxembourg, Netherlands, Poland, Portugal, Spain, Sweden, and the UK. 
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Precautions for Rack-Mounting

Warning To prevent bodily injury when mounting or servicing this unit in a rack, you must take special 
precautions to ensure that the system remains stable. The following guidelines are provided to ensure 
your safety: Statement 1006

Observe the following precautions for rack stability and safety. Also refer to the rack installation 
documentation accompanying the rack for specific warning and caution statements and procedures.

Note “Component” refers to any server, storage system, or appliance, and to various peripherals or supporting 
hardware.

• Do not move large racks by yourself. Due to the height and weight of the rack, a minimum of two 
people are needed to accomplish this task.

• Ensure that the rack is level and stable before extending a component from the rack.

• Do not overload the AC supply branch circuit that provides power to the rack. The total rack load 
should not exceed 80% of the branch circuit rating.

• Ensure that proper airflow is provided to components in the rack.

• Do not step or stand on any system or component when servicing other systems and components in 
a rack.

• This unit should be mounted at the bottom of the rack if it is the only unit in the rack.

• When mounting this unit in a partially filled rack, load the rack from the bottom to the top with the 
heaviest component at the bottom of the rack.

• If the rack is provided with stabilizing devices, install the stabilizers before mounting or servicing 
the unit in the rack.

Precautions for Products with Modems, Telecommunications, 
or Local Area Network Options

Observe the following guidelines when working with options:

• Do not connect or use a modem or telephone during a lighting storm. There may be a risk of 
electrical shock from lightning.

• Never connect or use a modem or telephone in a wet environment.

• Do not plug a modem or telephone cable into the Ethernet connector.

• Disconnect the modem cable before opening a product enclosure, touching or installing internal 
components, or touching an uninsulated modem cable or jack.

• Do not use a telephone line to report a gas leak while you are in the vicinity of the leak.

• Install the line-impedance filter to the modem. 
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Required Tools and Equipment
You need the following tools and equipment to install the MARS Appliance:

• Number 2 Phillips screwdriver

• Needle-nosed pliers

• Tape measure and level

• Antistatic mat or antistatic foam

• ESD grounding strap

Packaging Contents Checklist
Before unpacking the MARS Appliance, check the outside of the box for signs of damage from the 
shipment. If you suspect that the box was damaged during shipment, tell the carrier, and fill out the 
appropriate damage claims.

While unpacking the MARS Appliance, place the box so that the direction arrows on the box are facing 
up. Open the top of the box, and lift the appliance clear. Place the MARS Appliance on a clean flat 
surface. Re-inspect the appliance for damage.

Each appliance ships with the following items:

• One copy of Software License Claim Certificate

• One copy of Cisco Secure MARS Documentation Guide and Warranty

• One copy of Regulatory Compliance and Safety Information for the Cisco Security MARS 
Appliances.

• One appliance

• One Appliance Recovery DVD

• Two rail kit boxes, each containing two rack rails assemblies with screws (each rail kit supports a 
specific set of racks, see Selecting the Appropriate Rail Kit, page 3-10 for more information)

• Two to four sets of keys (depending on the appliance model)

• One or two standard computer power cords (depending on the appliance model)

• One telephone cable

• One Category 5 (Cat 5) crossover cable 

• One serial cable

• One xDSL In-line filter 

Review this checklist to ensure that each item is present. Write down the appliance’s serial number and 
license key and store them in a safe place. The serial number and license keys both appear as labels on 
the actual appliance. For information on locating these items, refer to the diagrams in Hardware 
Descriptions—MARS 110R, 110, 210, GC2R, and GC2, page 1-4.
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Selecting the Appropriate Rail Kit
The two rail kits provided with your MARS Appliance provide support for different types of appliance 
racks. You should select the rail kit that is compatible with your rack and ignore the other kit. Use the 
following guidance to select the correct rail kit:

• AXXBASICRAIL. This basic rail kit supports both threaded hole racks and square hole, enclosed 
racks, but it does not support non-threaded circular hole racks. Most racks use this kit.

• AXXHERAIL, This tool-less rail kit uses a hanging adapter that allows you to support non-threaded 
circular hole racks.

Web Browser Client Requirements
Before running the user interface provided by MARS, you must prepare Microsoft® Internet Explorer 
6.0 SP1 or later to connect to the MARS Appliance. This section describes the properly configured and 
patched web browser.

• Configuring Internet Explorer Settings, page 3-10

• Configuring Pop-Up Blockers, page 3-14

• Correcting Issues Caused by the 832894 (MS04-004) Security Update or the 821814 Hotfix, page 
3-15

• Obtaining the Required Browser Plug-ins, page 3-15

Configuring Internet Explorer Settings
You must use Microsoft® Internet Explorer 6.0 SP1 or later to connect to and configure the MARS 
Appliance. To run it with the MARS, you must configure your browser as follows:

• Set the browser’s cache to check the page every visit.

• Set security level to medium (at least) to enable ActiveX controls and scripting or add to the Trusted 
sites zone with its default settings.

• Set privacy to medium (at least) to enable cookies.

• Allow pop-ups from the MARS Appliance (disable pop-up blockers for the MARS Appliance).

To configure Internet Explorer to meet these requirements, follow these steps:

Step 1 Start Internet Explorer.

Step 2 Click Tools > Internet Options.

Step 3 On the General tab under Temporary Internet Settings, click Settings.
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Figure 3-1 Internet Explorer Page Cache Settings

Step 4 Click the Every Visit to the Page radio button.

Step 5 Click OK to close the Settings dialog box and to save your changes.

Step 6 On the Security tab under Select a Web content zone to specify its security settings, select Trusted Sites.
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Figure 3-2 Internet Explorer Security Settings

The default security level settings for Trusted Sites is Low. If this value is not Low or Medium, use the 
Custom Level settings to ensure that ActiveX controls and scripting are allowed.

Step 7 With Trusted sites selected, click Sites.
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Figure 3-3 Internet Explorer Trusted Sites

Step 8 Enter the URL used to connect to the MARS Appliance in the Add this Web site to the zone box and 
click Add.

Specify the full URL, preceded by https://; you can use either the DNS name or the IP address, such as 
https://192.168.0.1/, in the URL.

Step 9 Click OK to close the Trusted sites dialog box and to save your changes.

Step 10 On the Privacy tab under Settings, verify the selected value is Medium.
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Figure 3-4 Internet Explorer Privacy Settings

If the selected value is not Medium, slide the bar to Medium or click Advanced to define custom settings 
that will enable first-party cookies.

Step 11 Click Apply.

Step 12 Click OK to close the Internet Options dialog box and to save your changes.

Configuring Pop-Up Blockers
This procedure describes how to allow access to the MARS Appliance for users running Windows XP 
SP2, which includes a pop-up blocker. 

For information on configuring a different popup blocker to allow access to the MARS Appliance, refer 
to the documentation provided with the pop-up blocker product. 

To enable pop-up for Internet Explorer running on Windows XP SP2, follow these steps: 

Step 1 Click Options > Toolbar Options on the MSN toolbar.

Step 2 Select Pop-up Blocker under Toolbar.
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In the Allow list box, enter the host ID of the MARS prefixed by https://. For example, 
https://171.69.180.5/.

Note For later versions of the MSN Toolbar, you can access the Allow Lists tab by clicking the Popup Guard 
Settings button on Toolbar Buttons tab.

Step 3 Click Add to add the host to the list of sites for which pop-ups are allowed.

Step 4 Click OK to close the MSN Toolbar Options dialog box and to save your changes.

Correcting Issues Caused by the 832894 (MS04-004) Security Update or the 
821814 Hotfix

An issue introduced in a recent Internet Explorer security update, 832894, and in the 821814 hotfix can 
cause a “page cannot be displayed” error when you post to a site that requires authentication. If you have 
installed either of these updates, you must take corrective action to ensure proper operation with MARS. 
The following steps verify whether you have installed either update and points you to instructions 
provided by Microsoft to resolve the issue:

Step 1 Start Internet Explorer.

Step 2 Click Help > About Internet Explorer.

Step 3 Under Updated Version, look for Q832894.

If the Q832894 entry appears, you have the IE bug installed.

Step 4 If Q832894 entry appears, visit the Microsoft support web site to resolve the issue. The following 
knowledge base article provides specific instructions on resolving this issue:

http://support.microsoft.com/default.aspx?scid=kb;en-us;831167

Obtaining the Required Browser Plug-ins
The following plug-ins are required for use with MARS:

– Adobe® SVG Viewer plug-in to view the charts, graphs, and summary page data

You can either wait for the SVG viewer to install itself when you access the Summary page for 
the first time, or you can download it from:

http://www.adobe.com/svg/viewer/install/main.html

– Adobe Reader® to view the MARS documentation

You can download the latest Acrobat Reader plug-in from:

http://www.adobe.com/products/acrobat/readermain.html
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Web Browser Client Usage Guidelines and Notes
Familiarize yourself with the following usage guidelines and notes before using the MARS web 
interface:

• Avoid using the Refresh, Back, and Forward buttons in the browser. Using these buttons can lead to 
unpredictable behavior.

• Some pages, such as the Summary page, automatically refresh. Other pages do not. If you are 
viewing a page that is not automatically refreshed, you will be logged out of the user interface after 
a period of inactivity.

• Do not open multiple instances of the browser under the same login session. In other words, do not 
perform any of the following actions when viewing a page in the MARS web interface:

– Click File > New > Window on the menu bar of the browser.

– Enter Ctrl+N.

– Right-click a link on the page and select Open in New Window on the shortcut menu.
3-16
Install and Setup Guide for Cisco Security MARS

OL-13543-01


	Preparing for Installation
	Safety
	Warnings and Cautions
	General Precautions
	Maintaining Safety with Electricity
	Protecting Against Electrostatic Discharge
	Preventing EMI

	Preparing Your Site for Installation
	Environmental
	Choosing a Site for Installation
	Grounding the System
	Creating a Safe Environment

	AC Power
	Cabling
	Inline Filter for the Modem

	Precautions for Rack-Mounting
	Precautions for Products with Modems, Telecommunications, or Local Area Network Options
	Required Tools and Equipment
	Packaging Contents Checklist
	Selecting the Appropriate Rail Kit
	Web Browser Client Requirements
	Configuring Internet Explorer Settings
	Configuring Pop-Up Blockers
	Correcting Issues Caused by the 832894 (MS04-004) Security Update or the 821814 Hotfix
	Obtaining the Required Browser Plug-ins
	Web Browser Client Usage Guidelines and Notes




<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


